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CHAPTER 1

Overview

* Introduction, on page 1
* Installation Workflow, on page 1

Introduction

This guide provides instructions on how to install and configure Cisco HyperFlex Systems on Microsoft
Hyper-V.

To install Cisco HyperFlex Systems on VMware ESXi, refer to the installation guides available at:
https://www.cisco.com/c/en/us/support/hyperconverged-systems/hyperflex-hx-data-platform-software/
products-installation-guides-list.html

To install Cisco HyperFlex Systems for Edge (Remote and branch offices), refer to the deployment guides
available at: https://www.cisco.com/c/en/us/support/hyperconverged-systems/
hyperflex-hx-data-platform-software/products-installation-and-configuration-guides-list.html

Installation Workflow

The following illustration and table summarize the installation workflow:
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. Installation Workflow

Overview |

Preinstallation

Rack
Cisco HyperFlex Nodes
and set up Cisco UCS
Fabric Interconnects

Gather Complete Configure domain
’ Preinstallation ’ Preinstallation ’ administrator
Information Checklist for Active Directory

Installation
Digplor Configure Install Dgplier
HX Data ’ Cisoo ’ Microsoft ’ HyperVisor ’ HX Data Platform
: Platform UCS Manager Windows OS Configuration and create your
| Installer g HX cluster

Post Installation

Post HX Cluster
Configuration tasks

Task Description Reference
Preinstallation Rack HyperFlex nodes, and set up | See: Rack Cisco HyperFlex Nodes,
Cisco UCS Fabric Interconnects | on page 75
(FIs).
Complete Preinstallation checklist. | Preinstallation Tasks Summary
Installation Deploy HX Data Platform Installer | See: Step 1 - Deploying HX Data

using Microsoft Hyper-V Manager

Platform Installer.

Configure Cisco UCS Manager
using HX Data Platform Installer.

See: Step 2 - Cisco UCS Manager
Configuration, on page 21(using
HX Data Platform Installer)

Install Windows Server and Hyper
V, Deploy HX Data Platform and
create your initial cluster.

Step 3 - Microsoft OS Installation,
on page 30

Create Domain Administrator
(hxadmin) for Active Directory.

Enabling Constrained Delegation,
on page 10

Post Installation

Post HX Cluster Configuration
tasks.

Configuring a File Share Witness,
on page 56
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CHAPTER 2

Preinstallation Information

* Preinstallation Information, on page 3

Preinstallation Information

To ease your installation, gather the following information that you would require during installation. Download
the editable preinstallation sheet PDF from the following location:

Cisco HyperFlex Systems Preinstallation Information Sheet

Global Information

Cisco UCS Manager DNS Server 1
Version

NTP Server 1 DNS Server 2

NTP Server 2 Domain Name (AD)
Time Zone SCVMM Host
SMTP

Fabric Interconnect Information

Component IP Address Hostname Username Password Description

FI-VIP admin

FI-A admin

FI-B admin

IP-Ext-Mgmt: Must be same

(range) subnet as FI
mgmt at must at
least have 1 ip
pr. HX Node

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .
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. Preinstallation Information

Component IP Address Hostname Username Password Description

Subnet For EXT mgmt
and FI mgmt

Default For EXT mgmt

Gateway and FI mgmt

HX Installer

HX Installer

Subnet

HX Installer

Gateway

HX Installer Information

MAC Pools Prefix (00:25:B5)

HX Hetene | Node | Viapet | Vbuget | Node | HX Data |Data |(Opiond) |Live |Live |Live
Nodes Miapiet | Subnet | Default | Data | Contoller | Subnet | Default | Live | MybSint | Vigpaior | Migpaion
Heames IP Mask | Gaeway | IP Data |Mask |Gaeway | Vigalion Subnet | Default

IP IP Galenay

Node

Node

Node

Node

Node

Node

Node

Node

Cluster
Name
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Preinstallation Information .

HX Hotame | Node | MVbupret | Miapiet | Node | HX Data |Data |(Opiond) |Live |Live |Live
Nodes Niapret | Subnet | Default | Data | Contoller | Subnet | Default | Live | MybSbat | Vigpaior | Mipaion
Hobenes IP Mask | Gaeway | IP Data |Mask |Gaeway | Viyalion Subnet | Default

IP IP Gaenay

HX
Connect
Ul

HX
File
Cluster
Name

VLAN Information

Usage Name Default VLAN ID Chosen VLAN ID
Mgmt hx-inband-mgmt 3091
storage-data hx-storage-data 3092
Live Migration hx-livemigrate 3093
VM Network vm-network 3094

Hyper-V Information

HX Cluster Name

Hyper-V Cluster Name

Constrained Delegation

distinguished Name

hxadmin password
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. Preinstallation Information
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CHAPTER 3

Preinstallation Checklist

* System Requirements, on page 7
* Guidelines and Limitations, on page 9
* Preinstallation Tasks Summary, on page 9

System Requirements

Hardware Requirements

Requirement Description
Cisco HX Data Platform Servers Cisco HyperFlex M5 Converged nodes:
* All Flash—Cisco HyperFlex HXAF240c M5,
HXAF220c M5
* Hybrid—Cisco HyperFlex HX240c M5, HX220c
M5
Cisco UCS Fabric Interconnects (FIs) Cisco UCS Fabric Interconnects (FIs) 6200 and 6300
Network Services
Network Service Description
DNS Microsoft Active Directory and Active Directory

integrated DNS are required for the HX Platform.

Standalone DNS server is not supported.
Non-Windows DNS servers are not supported.
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. Port Requirements

Preinstallation Checklist |

Network Service

Description

NTP

Attention

Note

Note

Ensure that the time is synchronized between the
controller VMs and the hosts. For that purpose, use
the Active Directory Time Synchronization Engine.

Ensure that you use the Active Directory
domain name as the NTP server when
prompted by HX Data Platform Installer.

Do not nest all of your Active Directory
servers in your Hyperflex cluster. Active
Directory should reside outside of the
Hyperflex cluster so that if the cluster were
to encounter issues, you could still
authenticate.

If you are using Active Directory as an
NTP server, please make sure that the NTP
server is setup according to Microsoft best
practices. For more information, see
Windows Time Service Tools and Settings.
Please note that if the NTP server is not set
correctly, time sync may not work, and you
may need to fix the time sync on the
client-side. For more information, see
Synchronizing ESXi/ESX time with a
Microsoft Domain Controller.

Port Requirements

If your network is behind a firewall, in addition to the standard port requirements, Microsoft recommends
ports for the Hyper-V Manager and Hyper-V cluster. Verify that the following firewall ports are open.

Port Number Protocol Direction Usage
80 HTTP/TCP Inbound HX Data Platform Installer
443 HTTPS /TCP Inbound HX Data Platform Installer
2068 virtual Inbound hx-ext-mgmt IP pool (one IP
keyboard/Video/ per HX node)
Mouse (VKVM) /
TCP
22 SSH/TCP Inbound/Outbound HX Data Platform Installer
110 (secure POP POP3/TCP Inbound/Outbound
port is TCP; 995)
143 (secure IMAP |IMAP4/TCP Inbound/Outbound
port is TCP; 993)

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0
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Port Number Protocol Direction Usage

25 SMTP/TCP Outbound Mail Server

53 (external DNS/TCP/UDP Outbound DNS

lookups)

123 NTP/UDP Outbound NTP

161 SNMP Poll Inbound SNMP

162 SNMP Trap Outbound SNMP

8089 TCP Inbound HX Data Platform Installer
445 SMB 2 Inbound HX Controller VM

Guidelines and Limitations

For best experience with Microsoft Hyper-V installation, you must follow the specific guidelines listed below.

» Adding HyperFlex nodes to Microsoft System Center 2016 Virtual Machine Manager (Windows VMM
2016) evaluation version will cause errors. Refer to Microsoft help article for a resolution for this issue.

* The following features are NOT supported in the current release:

* SED Drives

* Native Replication

* Cisco HyperFlex Edge

* Stretched Clusters

* Intersight-based deployment

* LAZ and scale beyond 8 nodes

« HX M4 Hardware

Preinstallation Tasks Summary

Ensure the following is installed and configured prior to installing and deploying HyperFlex.

Task Description

Rack HyperFlex nodes including Cisco UCS Fabric | See: Rack Cisco HyperFlex Nodes, on page 75,
Interconnects set up

Verify Cisco UCS Manager version

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .


https://support.microsoft.com/en-us/help/4041074/update-rollup-4-for-system-center-2016-virtual-machine-manager

[ Adding DNS Records

Preinstallation Checklist |

Task Description

Verify VLANs Configure the upstream switches to accommodate
non-native VLANSs. Cisco HX Data Platform Installer
sets the VLANS as non-native by default.

Add DNS Records You must add DNS A and PTR records for your

installation. See: Adding DNS Records, on page 10

Configure Domain Administrator for Active
Directory

See: Enabling Constrained Delegation, on page 10

Adding DNS Records

Prior to the installation you must add DNS A and PTR records to avoid installation failures.

Device

Description

Hyper-V host

For each host, add an A and PTR record.

Controller node

Controller VM IP address for the A record. This is
ethO on the management IP network.

Windows Failover Cluster

Windows Failover Cluster Object.

HX Connect Ul

Cluster management IP address.

Refer to DNS Records section in this guide for the records shown as PowerShell commands to run directly

on your environment.

Enabling Constrained Delegation

The steps in this topic must be completed to enable constrained delegation.

Constrained delegation is used to join computers to the Active Directory. You provide constrained delegation
information through the HX Data Platform Installer. Constrained delegation uses a service account that is
created manually. For example: hxadmin. This service account is then used to log in to Active Directory, join
the computers, and perform authentication from the HyperFlex Storage Controller VM. The Active Directory
computer accounts applied to every node in the HyperFlex cluster include:

* Hyper-V host
* HyperFlex Storage Controller VM

* Hyper-V host cluster namespace

* Server Message Block (SMB) Share namespace for the HyperFlex cluster

Procedure

Step 1 Create an hxadmin domain user account as HX service account.

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0



| Preinstallation Checklist

Step 2

Step 3

Enabling Constrained Delegation .

Create an Organization Unit (OU) in Active Directory (AD), for example, HyperFlex.

a) Use the Active Directory Users and Computers management tool to create the OU. Select View > Advanced
Features to enable advance features. Select the OU that you created. For example, HyperFlex >
Properties > Attribute Editor.

b) Find the distinguished name attribute in the OU, and record the information as this will be required in the
Constrained Delegation wizard of the HX Data Platform Installer wizard. The values will look like this:
OU=HyperFlex, DC=contoso, DC=com.

Use the Get-ADOQOrganizationalUnit cmdlet to get an organizational unit (OU) object or to perform a
search to get multiple OUs.

Get-ADOrganizationalUnit
[-AuthType <ADAuthType>]
[-Credential <PSCredential>]
-Filter <String>
[-Properties <Stringl[]>]
[-ResultPageSize <Int32>]
[-ResultSetSize <Int32>]
[-SearchBase <String>]
[-SearchScope <ADSearchScope>]
[-Server <String>]
[<CommonParameters>]

Use Active Directory Users and Computers management tool to grant full permissions for the hxadmin user
for the newly created OU. Ensure that Advanced features are enabled. If not, go back to Step 2.

a) Select the OU that you created. For example, HyperFlex > Properties > Security > Advance.
b) Click Change Owner and choose your hxadmin user.
¢) Click Add in the Advanced view.

d) Select the principal and choose the hxadmin user. Then, choose Full Control, and click OK.
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. Enabling Constrained Delegation
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CHAPTER 4

Installation

* Installation Tasks Summary, on page 13

Installation Tasks Summary

The following table summarizes the steps to complete Microsoft Hyper-V installation.

Task Reference

Deploy HX Data Platform Installer Step 1 - Deploying HX Data Platform
Installer, on page 13

Configure Cisco UCS Manager (using HX Data Platform Step 2 - Cisco UCS Manager

Installer) Configuration, on page 21

Install Microsoft Windows Server Step 3 - Microsoft OS Installation, on
page 30

Hypervisor configuration, HX Data Platform and Cluster Step 4 - Hypervisor Configuration, HX

deployment Data Platform and Cluster Deployment
, on page 41

Step 1 - Deploying HX Data Platform Installer

Deploy HX Data Platform Installer using Microsoft Hyper-V Manager to create a HX Data Platform Installer
virtual machine.

Procedure

Step 1 Locate and download the HX Data Platform Installer. vhdx zipped file ( for example,
Cisco-HX-Data-Platform-Installer-v3.0.la-build-hyperv.vhdx) from the Cisco
Software Downloads site.

Step 2 Extract the zipped folder to your local computer and copy the . vhdx file to the Hyper-V host where you
want to host the HX Data Platform Installer. For example,
\\hyp-v-host01\. .. .\HX-Installer\Cisco-HX-Data-Platform-Installer-v3.0.1a-29499-hyperv.vhdx

Step 3 In Hyper-V Manager, navigate to one of the Hyper-V servers.

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .



. Step 1 - Deploying HX Data Platform Installer

Step 4

Step 5

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0
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Select the Hyper-V server, and right click and select New > Create a virtual machine. The Hyper-V Manager
New Virtual Machine Wizard displays.

EF
File Action View Help

e 2m B

Hyper-V Manager

"4'; Hyr-- U bl

I Virtual Marchines

g
I_ New

» Virtual Machine...

- [CPU Usage

Hyper-V Settings...

Edit Disk...
Inspect Disk...

Stop Service
Remowve Server
Refresh

View

Help

P itual Viachine...

Hard Disk...
Floppy Disk...

Virtual Switch Manager...
Virtual SAN Manager...

Assigned Memery  Uptime Status

Mo vitual machines were found on this server.

No virtual machine selected.

In the Before you Begin page, click Next.

4
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Step 1 - Deploying HX Data Platform Installer .

3 pew Virtual Machine Wizard ot

el Before You Begin

Before You Begin This wizard helps you create a virtual machine. You can use virtual machines in place of physical

computers for a variety of uses. You can use this wizard to configure the virtual machine now, and

Spedfy Name and Location you can change the configuration later using Hyper-V Manager.

Specify Generation
pedfy To create a virtual machine, do one of the following:
Assign Memory
» Click Finish to create a virtual machine that is configured with default values.

Configure Netwarking » Click Mext to create a virtual machine with a custom configuration.

Connect Virtual Hard Disk
Installation Options

Surmmary
] Do not show this page again
Finish Cancel §
Step 6 In the Specify Name and Location page, enter a name and location for the virtual machine where the virtual

machine configuration files will be stored. Click Next.

Note As a best practice, store the VM together with the . vhdx file.
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. Step 1 - Deploying HX Data Platform Installer

Spedfy Mame and Location you use a name that helps you easiy

UG S WS LETT OF WO KI0RS0

You can create a folder or use an existing folder to store the virtual machine. If you don't select a
folder, the virtual machine is stored in the default folder configured for this server.

[+] store the virtual machine in a different location

Location: |C:\ClusterStorage\volume 1\hx-installer\ || Browse... |

ﬁ“_\, If you plan to take chedkpoints of this virtual machine, select a location that has enough free
space. Checkpoints indude virtual machine data and may require a large amount of space.

Step 7 In the Specify Generation page, select Generation 1. Click Next.If you select Generation 2, the VM may
not boot.

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0
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Step 8

Step 1 - Deploying HX Data Platform Installer .

8 New Virtual Machine Wizard X

Specify Generation

Before You Begin Choose the generation of this virtual machine.

Spedify Generation This virtual machine generation supports 32-bit and 64-bit guest operating systems and provides
virtual hardware which has been avaiable in all previous versions of Hyper-V.

Assign Memory
Configure Networking O Generation 2
: This virtual machine generation provides support for newer virtualization features, has UEFI-based
Connect Virtual Hard Disk firmware, and requires a supported 64-bit guest operating system.
rstzkation Options & Once a virtual machine has been created, you cannot change its generation.
Summary

< Previous Next > Finish Cancel

In the Assign Memory page, set the start up memory value to 4096 MB. Click Next.
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. Step 1 - Deploying HX Data Platform Installer

EH Mew Virtual Machine Wizard *
= Assign Memory

Before You Begin Specify the amount of memory to allocate to this virtual machine. You can specify an amount from 32
ME through 12582912 MBE. To improve performance, specify more than the minimum amount
recommended for the operating system.

e Startup memary: 8192 MB

Configure Networking

Specify Name and Location

lUse Dynamic Memory for this virtual machine.

o When you decide how much memory to assign to a virtual machine, consider how you intend to

SER s use the virtual machine and the operating system that it will run.

Installation Options

Surmmary
< Previous Finish Cancel §
Step 9 In the Configure Networking page, select a network connection for the virtual machine to use from a list of

existing virtual switches. Click Next.
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Step 10

B mew Virtual Machine Wizard

— Configure Networking

Before You Begn
Spedfy Name and Location
Spedfy Generation
Assign Memory

Configure Netwarking

Connect Wrtual Hard Disk
Installation Options
Summary

Step 1 - Deploying HX Data Platform Installer .

Each new vrtual machne includes a network adapter. You can configure the netmork adapter to use a
prrected

Connection: | External Switch w

<Prm Firigh Cancel é

In the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, and browse to the folder
on your Hyper-V host that contains the . vhdx file. Click Next.

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .
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. Step 1 - Deploying HX Data Platform Installer

Connect Virtual Hard Disk

Connect Virtual Hard Disk

A virtual machine requires storage so that you can install an operating system. You can spedfy the
storage now or configure it later by modifying the virtual machine’s properties.

O Create a virtual hard disk
Use this option to create a VHDX dynamically expanding virtual hard disk.

Name: HX-Installer.vhdx

Location: .C:\clmterShurage\vob.uﬂelhxhstaller‘#ﬂ—lnstaﬂeﬂwwal Hard Di:. Browse...

Size: 127| GB (Maximum: 64 TB)

®) Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Location: |£:\ClusterStorage \volume 1\hx-installer\cisco-hx-data-platform-inst| | Browse...

(O Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later.

N> |

Step 11 In the Summary page, verify that the list of options displayed are correct. Click Finish.
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Step 12

Step 2 - Cisco UCS Manager Configuration .

EH Mew Virtual Machine Wizard *

Spedfy Generation DE=mipaE
Assign Memory Mame: Hx-Installer
Configure Networking Generation: Generation 1
) ) Memory: 8192 MB
Connect Virtual Hard Disk Metwork:  newprivate
Hard Disk:  C:\Users\Administrator, WIN-SRKBSHEOCFP\Desktop\ztemp build\Cisco-HX-Data-Platfar:
@ >

E Completing the New Virtual Machine Wizard

Before You Begin You have successfully completed the Mew Virtual Machine Wizard. You are about to create the

following virtual machine,
Spedfy Mame and Location R LN

To create the virtual machine and dose the wizard, dick Finish.

< Previous Cancel %

After the VM is created, power it ON, and launch the GUI.

a) Right-click on the VM and choose Connect.

b) Choose Action > Start (Ctrl+S).

¢) When the VM is booted, make a note of the URL (IP address of the VM). You will need this information

in the following steps in the installation.

Step 2 - Cisco UCS Manager Configuration

Step 1

The following procedure describes configuring Cisco UCS Manager using HX Installer.

Procedure

Log into the HX Data Platform Installer using the following steps:
a) In abrowser, enter the URL for the VM where HX Data Platform Installer was installed. If you do not

have the URL, go back to Step 13 in the earlier section on Step 1 - Deploying HX Data Platform Installer.

b) Use the credentials: username: root, password: Ciscol23

Important Systems ship with a default password of cisco123 that must be changed during installation.
You cannot continue installation unless you specify a new user supplied password.

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .
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. Step 2 - Cisco UCS Manager Configuration

¢) Read the EULA. Click I accept the terms and conditions.

d) Verify the product version listed in the lower right corner is correct. This version must be 3.0(1a) or later.
Click Login.

Chpco Hype Pl Conrect

& NotSecure | hbips: ) ho-gap-0 -mgmit.cisoolab. o

wiliai]ie
cIsco

Cisco HyperFlex Connect

-. HrFIe

Step 2 From the HX Data Platform Installer Workflow page, select I know what I'm doing, let me customize my
workflow.

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0
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Step 2 - Cisco UCS Manager Configuration .

p & ot Secure  Mips 10011228

el HyperFlex Installer

Select a Waorkflow

® B P
® ® ®.®
o = #
Step 3 On the next screen, click Run UCS Manager Configuration and then Continue.
K [P — - a
P A ot Secure | hilpa HOIOLI228:
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. Step 2 - Cisco UCS Manager Configuration

Caution Do not choose any other workflow option at this point.

Step 4 Click Confirm in the pop-up that displays.

Warning

You have selected a custom oplion that splits the installation or expansion workflow. You must complete all tasks in the workflow to ensure a working HX storage cluster.
If your nodes are data-at-rest encryption capable, custom installation is not supported.

Cancel to return to the standard workflow.,
Confwm and Proceed to continue with a custom workilow,

Cancel g

Step 5 UCS Manager Credentials

At this point the right side of the page is unused. Further in the setup process a configuration JSON is saved,
so in subsequent installations the JSON file can be imported to add the data quickly.

Complete the following fields for UCS Manager.

Field Description

UCS Manager Host Name FQDN or the VIP address of the UCSM.

UCS Manager User Name and Password Administrator user and password or an user with
UCSM admin rights.

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0
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Step 2 - Cisco UCS Manager Configuration .

[ Trese——— 0 e e e Lm—

e

Click Continue to proceed. The installer will now try to connect to the UCSM and query for available servers.
The configuration pane will be populated as the installer progresses. You can at any time save the JSON file
so you can re-use it for subsequent installations. This feature works on all the different workflows in the
installer. After the query finishes then you will get a screen with the available servers

Choose all the servers that you want to install in the cluster and click Continue.

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .
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Installation |

& NoiSecure iips

Server Selection

B BN o HTEr ol T 6 MY Berver. Tt b Bebaw 5 FEMFHTED 16 M5 BTV

Note HyperFlex for Hyper-V does only support M5 Servers.

Step 6 VLAN Configuration

HyperFlex needs to have at least 4 VLANS to function, each needs to be on different IP subnets and extended
from the fabric interconnects to the connecting uplink switches, to ensure that traffic can flow from the Primary
Fabric Interconnect (Fabric A) to the Subordinate Fabric Interconnect (Fabric B).

Name Usage ID

hx-inband-mgmt Hyper-V and Hyperflex VM 10
mgmt..

hx-storage-data HyperFlex storage traffic 20

hx-livemigrate Hyper-V Live Migration network |30

vm-network VM guest network 100,101

Use the following illustration as a reference for entering values in this screen.
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Step 2 - Cisco UCS Manager Configuration .

VLAN Configuration

VLAN for Hypervisor and HyperFlex management

VLAN Name VLAN ID

VLAN for VM Live Migration

VLAN for HyperFlex storage traffic

VLAN Name VLAN ID

VLAN for VM Network

VLAN Name

VLAN Name

-------------

VLAN 1D{s)

Note * Do not use VLAN 1 as it is not best practice and can cause issues with disjoint layer 2.

» vm-network can be multiple VLANs added as a comma separated list.

Caution Renaming the 4 core networks is not supported.

Step 7 Enter the remaining network configuration.
Field Description Value
MAC pool prefix MAC address pool for the HX 00:25:b5:xx

cluster, to be configured in UCSM
by the installer. Ensure that the mac
address pool isn’t used anywhere
else in your layer 2 environment.

Out-Of-Band network

IP blocks The range of IP addresses that are |10.193.211.124-.127
used for Out-Of-Band management
of the hyperflex nodes.

Subnet Mask The subnet mask for the 255.255.0.0
Out-Of-Band network

Gateway The gateway address for the 10.193.0.1
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* The Out-Of-Band network needs to be on the same subnet as UCS Manager.

* You can add multiple blocks of addresses as a comma separated line.

MAC Pool

MAC Pool Prefix

IP Blocks

'hx-ext-mgmt’ IP Pool for Out-of-band CIMC

Subnet Mask

Gateway

iSCSI Storage and FC Storage are used for adding external storage to the HyperFlex cluster. This is currently r

supported for the Hyper-V Edition.

Step 8 Advanced Section
Field Description Example Value
UCS Firmware Server Version Choose the appropriate UCS Server | 3.2(3a)
Firmware version.
HyperFlex Cluster Name This user defined name will be used
as part of the service profile naming
In UCSM for easier identification.
Org Name The org. name is used for isolating | HX-Cluster1
the HX environment from the rest
of the UCS platform to ensure
consistency.
HX-Clusterl
Note » The UCS C and B bundles must exist on the Fabric interconnect otherwise the installation will

fail. If the right version is not available in the drop-down list, then upload it to UCSM before
proceeding with this procedure.

* Currently supported version for HyperFlex Hyper-V is 3.2(3a).
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Step 9
Step 10

Step 2 - Cisco UCS Manager Configuration .

VLAN Configuration

VLAN for Hypervisor and HyperFlex management

WLAM Name WLAN 1D

WLAN for VM Live Migration

WLAMN Name WLAN 1D

MAC Pool

MAC Fool Prefin

"hx-ext-mgmt’ IP Pool for Out-of-band CIMC

P Blocks Submet Mask

» ISCSI Storage

» FC Storage

Advanced

WS Server Firmmvare Version

32{3a) v H-EAP-O

HyperFlex Cluster Name

VLAN for HyperFlex storage traffic

VLAN Mame VLAM D

WLAN for VM Network

VLAN Mame VLAN ilxs)

Gateway

Ong Hame

HX-EAP-01

Configuration *

Credentials

Server Selection

When you click Start, the installer validates your input and then begins configuring the UCS Manager.

When the HX Data Platform Installer is finished, then you are ready to proceed to next step, Step 3 - Microsoft

OS Installation, on page 30.

v UCSM Configuration Successful
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Step 3 - Microsoft 0S Installation

For Microsoft OS installation, you will need to first configure a vMedia policy in Cisco UCS Manager to map
the following two image files:

* Customer provided Windows 2016 Datacenter edition ISO, and

* Cisco provided Cisco HyperFlex Driver image.

These image files must be placed on a share that is reachable from Cisco UCS Manager and the Out-of-band
subnet that was used in the previous installation step. If you do not have a location to serve the files from,
then you can use the installer to host the files. Please see the section: How to upload the iso and img file to
the installer VM using WinSCP.

Note

Step 1

Step 2

Ensure network connectivity exists between the fileshare and all server management IP addresses.

Procedure

Launch Cisco UCS Manager::

a) In your web browser, type the Cisco UCS Manager IP address.

b) Click Launch UCS Manager.

c) In the login screen, enter the with the username as admin and the password set in the beginning of the
installation. Click Log in.

Create a vMedia policy for the Windows OS and Cisco driver images:

a) In the Navigation pane, click Servers.

b) Expand Servers > Policies > root > Sub-Organizations > hx-cluster_name > vMedia Policies

¢) Right-click vMedia Policies and select Create vMedia Policy HyperFlex.
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A F1-6332-A - Unified Com| X

(— c A Mot secure | hitpsy//10.29.149.205/app/3

Policies - Puolicies
* Policies

* oot +

00 200066€

root [ viMedia Policles

vMadla Policles

Yo Acvarced Fiter

4 Exporl M Print

¥ Adapter Policies T

* BI0S Defaults

i fe m

B80S Policles

» Boot Policies

id

Diagnostics Policias

* Graghics Card Policies

» Host Firmwane Packages
® IPMI Aocess Profias

r EVM Management Polickes

& m

Local Disk Config Policies

Maintenance Policies

¥

Management Finmware Packages

Mamany Policy

Power Corrol Policies

* Power Sync Policies

Scrub Policias

Serial ower LAN Policies

* Sarver Pool Policies

» Sarver Pool Policy Cualifications
* Threshold Policies

b ISCH Authentication Profles

wHIC HBA PR

el

Mo date avalabia

d) In the Create vMedia Policy dialog box, complete the following fields:

Field Name

Description

Name

The name of the vMedia policy. For example,
HX-vMedia.

This name can be between 1 and 16 alphanumeric
characters. You cannot use spaces or any special
characters other than - (hyphen), _(underscore), :
(colon), and . (period), and you cannot change this
name after the object is saved.

Description

A description of the policy. We recommend
including information about where and when the
policy should be used. Maximum 115 characters.
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Field Name Description

Retry on Mount Failure Designates if the vMedia will continue mounting
when a mount failure occurs. This can be:

* Yes
* No

Note The default setting is Yes. When Yes is
selected the remote server will continue
to try to mount the vMedia mount
process until it is successful or you
disable this option. If you select No, a
warning message will appear indicating
retry on mount failure will not work in
case of mount failure.

Refer to the following screeshot as an example:

Create vMedia Policy 2 X
Hame [ HX-vMedia
Description

Retry on Mount Falre: [ Mo (s) Yes
viMedla Mounts

+ = TeAdvenced Fler 4 Export ¥ Print O
Hame Type Protocol Authentica Server Filename Remote Pa.. User Remap on
Mo data available
®) Add

_—e—1

e) On the icon bar under the vMedia Mounts pane, click + Add. In the Create vMedia Mount dialog box,
complete the following fields:

Field Name Description Example Value
Name Name for the mount point. Windows-ISO
Description Can be used for more information. | Windows Server 2016 image
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Field Name Description Example Value

Device Type Type of image that you wantto | CDD
mount. This can be:

* CDD—Scriptable vMedia

CD.
* HDD—Scriptable vMedia
HDD.
Protocol The protocol used for accessing |HTTP
the share where the ISO files are
located.
Hostname/IP Address IP address or FQDN of the server | 10.101.1.92

hosting the images.

Image Name Variable This value is not used in None
HyperFlex installation.

Remote File The filename of the ISO file that
you want to mount.

Remote Path The path on the remote server to
where the file resides

Username If you use CIFS or NFS a
username might be necessary

Password If you use CIFS or NFS a
password might be necessary

Refer to the screenshot below as an example:
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Create vMedia Mount ? X
Name ;| Windows-1S0

Description - | Windows Server 2016 Image|

Device Type : [#)CDD () HDD |

Protocol : [ONFS O CIFS @ HTTP (O HTTPS |

Hostname/IP Address : | 10.29.149.212

Image Name Variable : [®)None () Service Profile Name |

Remote File . | en_windows_server_2016_x64_dvd_9327751.iso
Remote Path : | images/

Username

Password

Remap on Eject g

© - |

f) Click OK. When you click OK, you will now be returned to the vMedia Policies screen, and you should
see the information that you just submitted.
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Create vMedia Policy 2 X
Mame HX-=vMeda
Description

Retry on Mourt Failure: [0 No (@) Tes

viMedia Mounts

+ = TsAcdvanced Fiter 4 Export o Frint k=3
Name Type Protocol Auxhontica Sonver Filename Remote Pa...  User Remap on
Windo CDD HTTP Dt 10.29.145 @n_windo, fmagas. No
® add

_—

Repeat Steps 2e and 2f, however, change the type to HDD and the remote file name to the Cisco
HyperFlex driver image.

At the end of this step, the two vMedia mounts will be listed in the Create vMedia Policy screen as shown
in the following screenshot:
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Step 3

Create vMedia Policy ? X
o HX-vMedia
Description
Rutry on Maount Fallure: [) No (=) Yes J
videdia Mounts
4 = TeAdvanced Fited 4 Export ¥ Prind el
Hama Typa Protocol Authentica Sarver Filgnama Romaote Pa..  User Remag on
HX-Cis HDD HTTE Default 10.29.149 Hxdnstal- fmageas) Mo
Windo coD HTTP Darfauit 10.29.149, @n_windo, firnagos Mo
@ Agd
E

Associate the vMedia Policy to a Service Profile:

a) Inthe Navigation pane, select Servers > Service Profile Templates > root > Sub-Organizations >
hx-cluster_name > Service Template hx-nodes_name (example:hx-nodes-m5)

A FI-6332-A - Unified Com X

“—

(&} |A. Mot secure | bttps://10.29.149.205/app/3_2_3a/index.html

Sub-

* Senvice Template h-nodes Description vMedia policy to install or re-install software on HyperFlex servers

Retry on kount Failure @ Yes
viMedla Mounts

Service Profile Templates - . b
Service Profi... | root / ! HyperFlex |/ Service Tem...
Organizations Ll
* Service Profile Templates Genaral Storage Metwork ISCS1 vNICS vMedia Policy Boot Order Policies
* root Actions
* Sub-Organizations Madify |
VIOUITY VIV
* HyperFlax
Global vMedia Pollcy
» Senvice Template compute-nodes
MName HyperFlex
Sewvice Template compute-nodes- . ) -
b senice lempaie compuie-noces vMadia Policy Instance © org-roat/org-HyperFlax/mnt-elg-palicy-HyperFlax

* Sub-Organizations

+ = TeAdvanced Filled

Sarver Filenams

Name Type Pratoco

No data available
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b) Click the vMedia Policy tab. Then, click Modify vMedia Policy

¢) Choose the vMedia Policy that you created earlier from the drop-down selection, and click OK twice.

Modify vMedia Policy

vMedia Pnnc-,.' HyperFlex ¥ .

Select viMedia Policy to use

Create a Specific vMedia Policy

4+ = TpAdvanced Filter 4 Export & Print

Name Type Protocol Authenticat Server Filename Remaote Path  User

No data available

d) Under the General tab, verify that the vMedia policy is added to the Service Profile.

i Service Profiles | root suc h_nlz:lﬂuns HyperFlex | Service Profil..

* Sarvice Profes

Zow Peii
v ool
Actions Global viedia Policy
¥ Sub-Organzations
v HyparFia Marme HX-vhbedia
WG POBCY INSEANCE T OIg=NO0MAT=Chg - Py~ HX - vhtad
rack-unit-1 (HXGLLS) Deseriptior

¥ rack-unit-2 (HXCLUS Feedry on bount Failre © Yes
wiiledla Mounts

* rack-unit-3 (HECLLIS] -

+ =— TeAdwanced Flwer 4 Expor o Frint

¢ Sub-Organizafions

dame

Step 4 Modify Boot Policy and set the boot order to have CIMC CD/DVD to the list:

a) Inthe Navigation pane, click the Servers tab.

b) Expand Servers > Policies > root > > Boot Policies > Boot Policy HyperFlex-m5
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a =

“ € A ion swoume | e VRE BBRSA gl 5 Tt e 00 B i

®e 200C®

Sarewes | Fuicien | rost Acaba-ma | B Pofwion. | B Policy

$ B W g W™ F om 3

T e Syl Tim, F3IHB 310 FhR

¢) Inthe Boot Order configuration pane, click CIMC Mounted CD/DVD . Then, click Add CIMC Mounted
CD/DVD to add this to the boot order. Move it to the top of the boot order using the Move up button.

Important As shown in the screenshot below, the CIMC Mounted CD/DVD option must be highest in
the boot order preceding the other options, Embedded Local Disk and CD/DVD.

Boot Order

ik
i

+ = TYoAsvanced Fiter 4 Export

CIMC Mounted CD

CD/DVD

Local Disk

$ Movo Down [0 Delote E

d) Click Save Changes, and click OK in the Success dialog box. The modified boot policy is saved.

Step 5 Verify successful vMedia mounting:

a) On the Equipment tab, select one of the servers.
b) Click Inventory > CIMC, scroll down and ensure for mount entry #1(OS image) and mount entry #2
(Cisco HyperFlex driver image) you see status as Mounted and there are no failures.

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0



| Installation

Step 3 - Microsoft 0S Installation .

26 2000

hapying hama Windows 150 Typa =]
Progocod HTTR r 10.29.180.212
Por 5] Filerame  wn_windows_server_21E_xid_dvd SEXTT
Remote Path Amagos) Usor
* Fabric intenconnect B (subordirate) & Sonm Mowmad Mcunt Faikurs Reason- Hona
s Furbantication Progecol | Mome Rornag on Eject Ha
v Fupd Modue
& Emhaimat Poms
FL: Pt Mapging Mame HX-Clsco-Driver Type MDD
=T Profocol HTTR Sorwes 10.28.148.212
* PoRcas Port L] Filerame Hilersuall-Hypori-
R DataconterGors-v3.0. 1=
20665.Img
Remote Fath Amages) o
Satus Mowrned Wount Fallune Reason: None
Aurfantcation Pronscol © Mo Femag on Eject Ha
¢) Inthe menu bar, click Servers and choose the first HyperFlex service profile.
d) Click the General tab and choose Actions > KVM Console>>.
Note The KVM console will try to open in a new browser. Be aware of any pop-up blockers. Allow

the pop-ups and re-open the KVM
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KVM Console-Select IP Address

Service Profile derived:
(%) 10.29.149.191 (Outband)

@ Lounch Java KVM Console  OK | [ Cancel

e) Reboot the host, launch the KVM Console, and power on the server to monitor the progress of the Windows
installation. You should see the Loading Files screen appear. Windows should install automatically
without user intervention. You should see a blue screen and within a few moments you should see the
Setup is starting message. If automated installation does not begin, double-check that both images are
mounted to the server.

f) Once Windows installation completes, a command prompt will show up. Wait for the installation to
complete. The host will then reboot a few times. The installation is complete when you get a clear command
prompt at c: \users\administrator>

Note Ignore the prompt with the The system cannot find the file specified message.

Important Ensure that you have completed Steps e and f, on ALL servers that will be part of the HX
cluster.

g) Login to each server, enter the command c>Users>Administrator>Get-ScheduledTask and verify that
the HX Install Bootstrap Launcher task is running.

Step 6 Remove the vMedia policy from the service profile:

a) To un-map the vMedia policy from the service profile, go to Servers > Service Profile Templates >
root > Sub-Organizations > hx-cluster_name > Service Template hx-nodes_name
(example:hx-nodes-m5). Then, click on Modify vMedia Policy.

b) Under the vMedia Policy drop-down selection, deselect the vMedia policy (HX-vMedia) previously used
to map the two images.
Step 7 Restore the boot order to the one before installation:

a) In the Navigation pane, click the Servers tab.
b) Expand Servers > Policies > root > > Boot Policies > Boot Policy HyperFlex-m5
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In the Boot Order configuration pane, use the Move Down button to move CIMC Mounted CD/DVD
option to the bottom of the list.

Step 4 - Hypervisor Configuration, HX Data Platform and Cluster Deployment

After the installation of the OS is completed, perform the following steps to configure the hypervisor, install
the HX Data Platform Software and configure the cluster.

Procedure

Step 1 Hypervisor configuration

a)
b)

<)

d)

e)
f)

2

Re-open the HX Data Platform Installer and log in.

You might need to “start over” because the previous workflow was finished. Click on the gear icon in the
top right corner and select Start Over.

In the main menu, select I know what I'm doing, let me customize my workflow. In the Warning dialog
box, click Confirm and Proceed.

Complete information for the UCS Manager, Domain Information and Hypervisor Credentials.

Field Description Default Value

UCS Manager Host Name FQDN or the VIP address of the UCSM

UCS Manager User Name Admin user or an user with Admin
UCSM admin rights

Password Password for the UCS Manager User Name

Domain Name Active Directory domain name that the HyperFlex cluster is going
to be a member off.

Local Administrator User Name |Local Administrative username | Administrator
on the Hyper-V Hosts

Local Administrator Password Password for the local Cisco 123
administrative user on the
Hyper-V hosts

Note If you haven’t changed the Administrator password for the Windows Hyper-V in the previous
step the default value is as shown above.

The HX Data Platform Installer now connects to UCS Managaer and lists the relevant servers for the HX
Cluster. The HX Data Platform Installer now validates UCS Firmware etc.

Validate the selected servers and click Continue.

Complete the network information as you have done in the chapter: Cisco UCS Manager Configuration
using HX Data Platform Installer and ensure the data is the same. Click Continue to proceed to next
screen.

Configure Hypervisor Settings. Input the values for the Hypervisor configuration as show below
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Step 2

Field Description Example Value

Configure common Hypervisor Settings

Subnet Mask Subnet mask for the hypervisor |255.255.255.0
hosts management network

Gateway Default gateway for the 10.101.251.1
hypervisor hosts management
network

DNS Servers Comma separated list for the DNS | 10.99.2.200,10.992.201

Servers in the AD that the
hypervisor hosts are going to be

member of.

Hypervisor Settings

Static IP address Management IP address for each | 10.101.251.41
host

Hostname Hostname for each host HX-Hypv-01

Note If you leave the checkbox Make IP Addresses and Hostnames Sequential as checked then
the installer will automatically fill the rest of the servers sequential from the first.

Click Start to begin the Hypervisor Configuration.

The installation now continues and configures the Hypervisor hosts.

Important Be aware that even if the steps are completed as shown above, the Hypervisor configuration is
not completed. The servers are working in the background until the installer reports an overall
completion.

HX Data Platform Deployment

a)
b)
¢)

d)
e)

You may need to start over because the previous workflow was completed. In the top right corner of the
install, select Start Over, confirm that you wish to start over.

In the HX Data Platform Installer Workflow page, select I know what I'm doing, let me customize my
workflow.

Check the Deploy HX Software and Create HX Cluster and click Continue.
In the warning message, click Confirm and Proceed.

Domain information, Constrained Delegation, Hypervisor Credentials. Use the following table to
complete the fields in this page.

Field Description Example Value

Domain Information

Domain Name Active Directory Domain that the | contoso.com
cluster will be a part of.
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Field

Description

Example Value

HX Service Account

The HX service account that was
created in the preinstallation
phase.

Important Verify that the Active
Directory policies allow|
HX service account to
have effective
permissions to “Write
servicePrincipalName”
on the computer object
created for smb
namespace.

hxadmin

Password

Password for the HX service
account.

Constrained Delegation

HX Service Account and
Password

Required for Constrained
Delegation.

Use HX Service Account

Uses the HX service account for
Constrained Delegation. The user
must be a domain administrator.

Click checkbox if HX service
account is provided.

Configure Constrained Delegation
now (recommended) or Configure
Constrained Delegation later

Select one of the checkboxes.

Constrained Delegation is
required for VM Live Migration.
To configure Contrained
Delegation later, use the
procedure described in
Configuring a Static IP Address
for Live Migration and VM
Network, on page 53.

Advanced Attributes (optional)

Domain Controller

FQDN for the Domain Controller
that you want to use specifically
for the installation.

dc.contoso.com

Organization Unit

The OU created during the
preinstallation phase can be used
here Then, the OU will be the
home for the HX nodes in the
Active Directory.

OU=HyperFlex, DC=contoso,
DC=com

Hypervisor Credentials
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Field

Description

Example Value

Hypervisor Local Administrator
User Name

Local administrator username on
the Hyper-V hosts

Default username/password:
administrator/Cisco123

Important Systems ship with a
default password of
Cisco123 that must be
changed during
installation. You
cannot continue
installation unless you
specify a new user
supplied password.

Click Continue.

IP Addresses. Click Add Server to add the servers you need for the cluster.

Complete the hostnames for the Hyper-V hosts and the Storage Controllers running on the Hyper-V hosts.
These hostnames must be added to forward and reverse look up prior to this step. Remember that only
Windows AD Integrated DNS is supported.

Complete the data IP addresses for both the Hyper-V hosts and controller VMs.

Note

Use the following table to complete the fields in this page.

The management VLAN uses the addresses and Data VLAN does not.

Field Description Example Value

Management

Cluster Address Hostname for the HX Connect Ul | HX-EAP-01-MGMT

Subnet Mask Subnet mask for the management | 255.255.255.0
VLAN

Gateway Gateway address for the 10.101.251.1
Management VLAN

Data

Cluster Address IP address for the HX cluster on |10.101.252.50
the Data VLAN

Subnet Mask Subnet mask for the management | 255.255.255.0
VLAN

Gateway Gateway address for the 10.101.252.1
management VLAN.

Click Continue.

Cluster Configuration
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a) Cisco HX Cluster Configuration.

Use the table below to complete the fields in this page.

Field Description Example Value
Cisco HX Cluster

Cluster Name (SMB Access The cluster name to be used as the | HX-EAP-01
Point) FQDN for the datastores.

Replication Factor Select the number of redundant |3 (Default Value)

data replicas across the HX
storage cluster. Options are 2 or
3. This cannot be changed after
the cluster is created. 3 is
recommended for production
workloads.

Failover Cluster Name The name used for the Windows
Failover Cluster.

Controller VM

Create Admin Password

Confirm Administrator Password

System Services

DNS Servers Comma separated lists of DNS | 10.99.2.200, 10.99.2.201
Servers.
NTP Servers The controller VMs needs must |dcl.contoso.com,

be in sync with Windows Active |dc2.contoso.com
Directory, therefore you must
point to your AD domain
controllers for time

synchronization.

DNS Domain Name The domain name for the Active |contoso.com
Directory.

Timezone The timezone that you want the

HX controllers to report in.

Auto Support

Enable Connected Services Auto Support to ship telemetry
data of the HX cluster to Cisco
Support.
Send Service ticket to Email address or alias to receive |email address

a copy of the ticket sent to Cisco.
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Field

Description

Example Value

Advance Networking

Management VLAN tag

VLAN used for the Management
Network. This must be the same
as used earlier in the installation
process for the management
network.

Data VLAN tag

VLAN used for the Management
network. This must be the same
as used earlier in the installation
process for the data network.

Advanced Configuration

Enable Jumbo Frames on Data
network

Sets the MTU size for the storage
data network on the host
vSwitches and vNICs, and each
storage controller VM. The
default value is 9000. To set your
MTU size to a value other than
9000, contact Cisco TAC.

Ensure that jumbo frames run on
the links connected to the storage
VMs.

Disk Partitions

Removes all existing data and
partitions from all nodes added to
the storage cluster. You must
backup any data that should be
retained. Select this option to
delete existing data and partitions.

This is for manually prepared

servers. Do not select this option
for factory prepared systems. The
disk partitions on factory prepared
systems are properly configured.

VDI

Configures for VDI only
environments. To change the VDI
settings after the storage cluster is
created, shutdown or move the
resources, make changes, and
restart the cluster.

Hypervisor Settings

Primary DNS suffix

Completed in earlier steps in the
installation.
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Field

Description

Example Value

Additional DNS suffixes

Hyper-V hosts.

Complete this field if you need
more suffices appended on your

Refer to the illustration below as a sample entries for the various fields in this page.

Cisco HX Cluster

Chuster Mame [(SMB Access Polrt)

hx-gap-01

Controller VM

Create Admin Pasywerd

wrnemnn e @

Advanced Metworking

Mianagement VLAN Tag

2996

Dafa VLAN Tag

2997

Advanced Configuration

Jumbo Frames

Enable jumbo Frames.on

-
Data Netwerk

Repiication Factor

3 :

Canfinm Adenin Pasywornd

B £

System Services
OMS Server(s) NTP Server(s)
10.56.2.200,10.90.2, 201 Clscolab,di
Time Zone
TS+ 000} Brussely, Copenhagen, badsid, Paris H
Auto Support
Auto Suppart Send service ticked notifications to
Enable Connedted Services
[Recommended) lagranbe@cisco.com

Management viwitch

weswi che ha-inband -mgmi

Data viwitch

wswitche hasstorage-data

Disk Partitions

# Clean up disk partitions

Fadover Chuster Name

HX-EAP-CLUD

OIS Dhomadn Namie

crscolab dic

Virtual Desktop (VDI)

Optiemaze for VDI cnly
deployment

Configuration -

Credentials
Crerodab dic
hapdmin
Romance Standard Time
AL S
P Addresses
ha-gap-0f
PEG-EAPON-RAGAT
1010125250
2552552550
I55.I55.1550
101012500
10012520
Server 0
HEAP-1 Crsoodabodic

HAEAPA-
CNTLCrseadab dic

10,101 252 41
10001 2525

Server 1
HX-EAP-T.Crocodab ok

HGEAP: 2
ONTLChpodab dic

10001 T52AZ
10101 252 82

Server 2
HOEAP. 3 Cincodab di

HA-EAP-3-

Click Start to begin the deployment. The Progress page displays the progress of the configuration tasks:

Start, Deploy Validation, Deploy, Create Validation, Cluster Creation.
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Installation |

".) Cluster Creation in Progress

Cluster Creation - Overall

In Progress

hx-eap-01

-

Cluster Creation

ZK ensemble

Init Management Service

Storage HxCluster

O

Cluster
Creation

a

Caution Do not skip validation warnings.

See the Warnings section for more details.

¢) When the following screen is displayed, the installation process is completed.
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Configuring a Static IP Address on HX Data Platform Installer .

hx-eap-01 U [ERI

Version

Cluster Management IF

Cluster Data IP Address

Replication Factor

Aadlable Capacity

Servers

Model

MXAF220C-M55X

HICAF2 200-M55%

HAF220C-MESN

HICAF220C-M55X

Address

Serial Number

WIPZ148075Y

WIPZ14BOTSC

WIFE14B07R

WIZP214807RE

300829459

HX-EAP-O71-MGMT.Ciscolab.dk

Management Hypenisor

10101251 41

10.000.250 44

100025142

10L101.251.43

10.101.252.50

Three coples

GaTE

Domain Name

Failover chuster Name

DINS Serwerls)

NTPF Server(s)

Management Storage Controllar

1091.251.51

1000125154

1000.251.52

10.101.251.53

[Data Metwork Hypervisor

1010025141

10000250 .44

10000125142

1010125142

Back o Warkllow Selection

Crscolabudic
H{-EAP-CLUGA
10992200, 10.99.2.201

Ciscolat.dk

Data Network Storage Controdler
10.101.252.51
10.107.252.54
10.101.252.52

10.101.252.53

Configuring a Static IP Address on HX Data Platform Installer

During a default installation of the VM, the HX Installer will try and automatically obtain an IP address using
DHCEP. To ensure that you have the same IP address at every boot, you can assign a static IP address on the

VM

Use the following commands to configure your network interface (/etc/network/interfaces) with a static IP

address. Make sure you change the relevant settings to suit your network.

Procedure
Command or Action Purpose
Step 1 Run the following command: ifdown eth0. Warning This step ensures that the interface
is down before performing the static
IP configuration. Failure to do so
could lead to issues during the
installation process that may require
TAC support.
Step 2 Using your favorite editor, edit the auto eth0 # eth0 interface
/etc/network/eth0.interface fileto | f3ce ethO inet static # configures
. static IP for the ethO interface
match your environment. For example, add the | ot ic 100
following lines in the file: address XX.XX.XX.XX # Static IP address
fr the installer VM
netmask 255.255.0.0 # netmask for the
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. Configuring a Static IP Address on HX Data Platform Installer

Command or Action Purpose

Static IP addresss

gateway XX.XX.X.X # gateway for the
Static IP addresss

dns-nameservers XX.XX.X.XXX #DNS name
servers used by the HX installer
dns-search <DNS_Search Name>.local # DNS
search domain name used by the installer

Step 3 Save the file so that the changes take effect.

Step 4 Run the following command: ifup eth0

Step 5 Reboot the installer VM.
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* Post Installation Tasks Summary, on page 51

Post Installation Tasks Summary

CHAPTER 5

After successful cluster configuration, perform the following addition post installation tasks to ensure that

the cluster is ready to serve VMs.

Task

Reference

Create the First Datastore

Create the First Datastore, on page 51

Assign a static IP address for Live Migration and
VM Network

Configuring a Static [P Address for Live Migration
and VM Network, on page 53

(Optional) Constrained Delegation

(Optional) Post Installation Constrained Delegation,
on page 54

Configure Local Default Paths

Configure Local Default Paths, on page 55

Configure File Share Witness

Configuring a File Share Witness, on page 56

Checking the Windows Version on the Hyper-V
Host

Checking the Windows Version on the Hyper-V Host,
on page 61

Validate Failover Cluster Manager

Validate Failover Cluster Manager, on page 61

Deploying VMs on a Hyper-V cluster

Deploying VMs on a Hyper-V cluster, on page 63

Configuring HyperFlex Share to SCYMM

Configuring HyperFlex Share to SCVMM, on page
69

Re-enabling Windows Defender

Re-enabling Windows Defender, on page 71

Create the First Datastore

Before you begin using the cluster, you must create a datastore. The datastore can be created in HX Connect

UL
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. Create the First Datastore

Procedure

Step 1 Launch HX Connect UI from a browser of your choice from https://Cluster IP/ or https://FQDN.

Ciuon HyparFlex Connect

A Not Secure | hiips: ha-sap-01-momi ciscolab.dic

ll:ll‘llt
CIsco

Cisco HyperFlex Connect

Step 2 Log in with the following credentials:

¢ Username—hxadmin

» Password—Use the password set during cluster installation.

Step 3 In the Navigation pane, select Datastores.

. Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0
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o R0 My TF b Caonnct

Configuring a Static IP Address for Live Migration and VM Network .

A Mot Secure g hu-sap-0l-mami ciscolab.di

tuia HyperFlex Cannect

@ Dashboard
MOKTTOR

® fveras

] Acthizy

AMMLYTE

Ll Performance

MANAGL

B system information

B oaustones

F- 3 Upgrade

hat-eap-01

S OPERATIONAL STATUS
) online

RESILIENCY HEALTH

)
“i~  Hea Ithy o 1 Mode failure can b toberated

£, CAPACITY I.I 1% STORAGE SO CPU I, CHMErEon Ml

i 64718 - OPTIMEATION cpduphoation ration il be caliulaeed onoe we e
~— - 1 4 = Tl T e g NSl A

(— I 4 HAAFZIOCMESE

==

== 4 Converged

o Bpad g Gk 8 Vo e A Wi 4 e 105

{\—\/\W“—V—W——

Throughget (MBpa) Last § Rour » Raad M O Mmd A 0 » Wit b 05 Min 008 e 015
/\___\vf\/‘\/\\/\/\/ﬂr'-h‘——v—f\—\/\w: e
Laguency [miad] Lagk 1 B = Bipad bl O MO © Wit M .55 M2 ) e 185

Step 4 In the Work pane, click Create Datastore.

Step 5 In the Create Datastore dialog box, complete the following fields:

Field

Description

Datastore Name

Enter a name for the datastore.

Cisco recommends that you use all lower case
characters for the datastore name.

Size Select the size for the datastore.
Block Size Select the block size for the datastore.
Note Cisco recommends 8K block size and as few datastores as possible to ensure the best performance.

Configuring a Static IP Address for Live Migration and VM Network

Log in to each Hyper-V node and execute the following commands in Power Shell to assign a static IP address
for Live Migration and VM Network.
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. (Optional) Post Installation Constrained Delegation

# Command Purpose
1 New-NetIPAddress -ifAlias Assigns a static IP address to the
"vSwitch-hx-livemigration" -IPAddress Live Migration network.

192.168.73.21 -PrefixlLength 24

2 New-NetIPAddress -ifAlias Assigns a static [P address to the
"vswitch-hx-vm-network" -IPAddress VM network.
192.168.74.21 -PrefixlLength 24

(Optional) Post Installation Constrained Delegation

[ L]

Attention

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

This step must be performed only if Constrained Delegation was not configured during initial installation. It
is recommended that you perform this procedure using the HX Installer and not as part of post-installation.

Constrained Delegation gives granular control over inpersonation. When the remote management requests
are made to the Hyper-V hosts, it needs to make those requests to the storage on behalf of the caller. This is
allowed if that host is trusted for delegation for the CIFS service principal of HX Storage.

Constrained Delegation requires that the option for the security setting User Account Control: Behavior of
the elevation prompt for Administrators in Admin Approval Mode is set to Elevate without Prompting.
This will prevent the global AD policy from overriding policy on HX OU.

Perform the following procedure on each Hyper-V host in the HX Cluster to configure using Windows Active
Directory Users and Computers.

Procedure

Click Start, click Administrative Tools, and then click Active Directory Users and Computers.

Expand domain, and then expand the Computers folder.

In the right pane, right-click on the computer name (for example, HX-Properties), and then click Properties.
Click on the Delegation tab.

Select Trust this computer for delegation to specified services only.

Ensure that Use any authentication protocol is selected.

Click Add. In the Add Services dialog box, click Users or Computers, and then browse or type the name
of the Service Type (such as CIFS). Click OK. The following illustration can be used as an example.
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Configure Local Default Paths .

Location | Managed By | Object | Secuity | Dialin | Attribute Editor
General | Operating System | MemberOf | Delegation | Password Replication

Delegation is a securty-sensitive operation, which allows services to act on
behalf of another user.
) Do not trust this computer for delegation
() Trust this computer for delegation to any service (Kerberos only)
(®) Trust this computer for delegation to specified services only
() Use Kerberos only
(®) Use any authentication protocol
Services to which this account can present delegated credentials:
Service Type  User or Computer Port Service Ni
cifs h-eap-01.Ciscolab.dk
HX-EAP-1
HX-EAP-1

Step 8 Repeat these steps for all nodes.

Configure Local Default Paths
Configure the default local path for the VMs to ensure that they will be on the HX cluster datastore.

Run the following commands in PowerShell:

$Creds = Get-Credential -Message "User Credentials" -UserName <<current logon username>>

Shosts = ("hostnamel", "hostname2", "hostname3", "hostname4")
Invoke-Command -ComputerName $hosts -Credential $Creds -ScriptBlock {Set-VMHost
-VirtualHardDiskPath

"\\HX-EAP-01l.ciscolab.dk\DS1 8K" -VirtualMachinePath "\\HX-EAP-0l.ciscolab.dk\DS1 8K"}
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. Configuring a File Share Witness

\}

Note

Remember to change the variables to suit your environment.

Configuring a File Share Witness

Step 1
Step 2

Step 3

As a Microsoft best practice, ensure that you configure a Quorum witness datastore. Use the following
procedure to configure a File Share Witness using Failover Cluster Manager (FCM).

Procedure

Launch FCM.

In the navigation pane, select your cluster. Then, in the Actions pane, select More Actions > Configure
Cluster Quorum Settings....

] Fatorver Chamter Manager = o x
Pl datan  Weew  Medp
e nm B
L
«‘R;‘-ﬂ-«' Chuter Mansger Cluster HX EAP-CLUD1 ciscalab.dic Aetiom
w HE-LAP-CLUN cralab.i
- HOC-EAR LU Ereslab g
™ Reim 'i? Summary of Chustor HX-EAP-CLUD1 = _|
B Hedes © BOCEAPCLLION huas O chusbored rmbes arsd 4 nodes. 5 Conlgue Bote
¥ i Soree Homar: HCEAP CLUDN cmcolt Hetworkn: bkt bt bt A vekdate Chuste
é!cu}:.-:}u Cuvert Host Sorver: HELAPT Subnats: 3 Pvd and 0 %vE S View Validation Repoet
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The Configure Cluster Quorum wizard is launched. Click Next.
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Step 4

Step 5

Configuring a File Share Witness .

[

Before You Begin

Select Quorum
Configuration Option

Select Quonum
Witness

Confirmation

Configure Cluster
Quorum Settings

Summary

&7 Configure Cluster Quorum Wizard *

;i? Before You Begin

This wizand guides you through configuring the quarum for your failover cluster. The relevant cluster
elements are the nodes and. in some quorum configurations, a disk witness or file share winess.

The quorum configuration affects the availabiity of your cluster. A sufficient number of custer slaments
must be online, or the cluster Toses quorum™ and must stop running. Note that the full function of a cluster
depends not only on the quorum, but also on the capacity of each node to support the clustered roles.

Impostant: Run this wizard only if you have determined that you need to change the quorum corfiguration
for your chuster. When you create a cluster, the dluster software automatically chooses a quonm
configuration that will provide the highest avadahilty for your clustes.

To continue, click Next.

In the Select Quorum Configuration Option screen, choose Select the quorum witness. Click Next.

Before You Begin

Select Quorum

Configuration Option

Select Quorum
Witness
Confirmation

Configure Cluster
Quonum Settings

Summary

b Cenfigure Cluster Quorum Wizard X

Select Quorum Configuration Option

Select a quorum configuration for your cluster.

(O Use default quorum corfiguration
The cluster determines quorum management options, including the quorum witness.

(@) Select the quorum witness
You can add or change the quorum witness. The cluster determines the other quorum management
options.

(O Advanced quorum configuration
You detemine the guonum management options, including the quorum witness.

Fallover Cluster Quorum and Witness Configuration Options

[ <Prvious |[ _Net> || Cancel

In the Select Quorum Witness screen, choose Configure a file share witness. Click Next.
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. Configuring a File Share Witness

3_”, Configure Cluster Quorum Wizard

4 Select Quorum Witness

i33:-
=]
Before You Begin Select a quorum witness option to add or change the quorum witness for your cluster corfiguration. As a
best practice, configure a quorum witness to help achieve the highest availability of the cluster.
Select Quorum
Configuration Option

(O Configure a disk witness
Witness Adds a quorum vote of the disk witness

Select Quorum

Configure File Share
Witness (® Configure a file share witness

T e Adds a quorum vote of the file share witness

Configure Cluster () Configure a cloud witness
Quorum Settings Adds a quorum vote of the cloud witness

Summary
() Do not configure a quorum witness

Failover Cluster Quarum and Witness Confiquration Options

| <Previous |[__MNet> || Cancel

Step 6 In the Configure File Share Witness screen, specify the path to the File Share. Click Next.
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Step 7

Configuring a File Share Witness .

Before You Begin
Select Quorum
Configuration Option
Select Quorum
Witness

Conrfigure File Share

Witness

Confimation

Configure Cluster
Quorum Settings

Summary

&E Configure Cluster Quorum Wizard

li? Configure File Share Witness

Please select a file share that will be used by the file share witness resource. This file share must not be
hosted by this cluster. It can be made more available by hosting it on another cluster.

File Share Path:
[\\HX-EAP-01 ciscolab dk\DS1_8K]

|| Browse...

<Pre~.-bus_| Next > |Cancal

In the Confirmation screen, click Next.
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o Configure Cluster Quorum Wizard X
J'f'i Configure Cluster Quorum Settings
Before You Begin Please wait while the quorum settings are corfigured.
Select Quorum
Configuration Option
Select Quorum
Witness
Configure File Share
Witness
Confirmation
Configure Cluster
Quorum Settings
Summary
:
Step 8 In the Summary screen, click Finish to close the wizard.
Step 9 Alternatively, you can configure a file share witness using Windows PowerShell.
a) Open a Windows PowerShell console as an administrator.
b) Type Set-ClusterQuorum -FileShareWitness <File Share Witness Path>
¢) You should now see the File Share Witness configured for your cluster. When you navigate to your File
Share Witness share you will see a folder created for your cluster.
(») Cluster Core Resources
Name Status Information A

® 0% Name: HX-EAP-CLUOD1
Cluster Infrastructure
8 Virtual Machine Cluster WMI
File Share Witness
@y File Share Witness (\\HX-EAP-01 ciscolab.dk\DS1_8K)

(® Online
@ Online
@ Online v
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Checking the Windows Version on the Hyper-V Host

Follow the steps below to check the version of Windows installed.

Procedure
Step 1 Login to the Hyper-V server as an administrator or HX Service Administrator account.
Step 2 In Powershell, run the following command:

C:\Users\adminhyperflex> Get-ItemProperty 'HKLM:\SOFTWARE\Microsoft\Windows
NT\CurrentVersion'

Step 3 Verify the installed Windows version in the result of the command output.

Following is a sample output if you have installed Windows Server 2016.

ProductName : Windows Server 2016 Datacenter
ReleaseId : 1607

SoftwareType : System

UBR : 447

Step 4 In addition, verify the following:

» The UBR # should be greater than 1884. If not, upgrade the HyperV servers to the latest update. Refer
to the Microsoft Knowledge Base article: KB4467691.

* If you are using a standalone HyperV manager outside HX nodes then, the Hyper-V management server
should have a version UBR # greater than 1884. You must upgrade the Hyper-V management server if
the version is 1884 or lower.

Validate Failover Cluster Manager

Procedure

Step 1 Open the Failover Cluster Manager Manager and click Validate Cluster and then click Next.

Witness: Fie Share Wiress (VHYFERS-SHB Fu local'civis_guonam

~) Configure

Conif arvadability for 2 spechic dustered role. add one or mone senvers (nodes). or copy roles om a cluster runnng 1Windows Server
n upporied prevecus versiors of iiindows Server

u P dation Report
Mk F Add Mode...
T Add b 4 Close Conmaction
£) Reset Recent Events
P Mo Acticas
Wiew
~) Navigate i Refresh
Properties
L L Ll

B Hep
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. Validate Failover Cluster Manager

Step 2 Select Run all tests (recommended) and then click Next.

—ﬂ Validate a Configuration Wizard X

w Testing Options

Before You Begin Choosa between running all tests or running selacted tests

Testing Options The tests examine the Cluster Configuration, Hyper-V Configuration, Inventory, Network, Storage. and
Corfrmation Sﬁﬂﬂ Cuiwa‘.m

Validating Microsoft supports a cluster solution only if the complete configuration (servers, network, and storage) can
5 pass all tests in this wizard. In addition, all hardware components in the cluster solution must be "Certified
SLmmany for Windows Server 2016."

(®) Run all tests recommended)
(C) Run only tests | select

<Previous || Net> || Cancel

After clicking Next, the validation procedure starts running.

Step 3 Verify that there are no validation failures. If there are any validation failures, click View Report and address
any results that show Failed.
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8 validate a Configuration Wizard X
J:l};? Validating

Begir The following validation tests are running. Depending on the test selection, this may take a significant
amount of time.

Progress

passed

Test is currently runnin +
< »

Deploying VMs on a Hyper-V cluster

Deploying VMs on a Hyper-V cluster is a multi-step process as described below:

* Install Remote Server Administration Tools (RSAT) on the management station/host—You must
install administrator tools such as Hyper-V Manager and Failover Cluster Manager as features Server
Manager. For more information see, Install RSAT tools on the Management Station or Host, on page
63.

* Manage VMs—Connecting to all the Hyper-V nodes in the HX cluster and creating new VMs can be
accomplished using either Hyper-V Manager or Failover Cluster Manager. For more information see,
Creating VMs using Hyper-V Manager, on page 68, Creating VMs using Failover Cluster Manager, on
page 68, or Creating ReadyClone VMs.

Install RSAT tools on the Management Station or Host

To install RSAT, complete the following steps:

Before you begin
RSAT tool installation requires the following:

* A server from which you can install, manage, monitor the VMs on the Hyper-V HX cluster.

* Administrator tools such as Hyper-V Manager, FCM, PowerShell, SCVMM.
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. Install RSAT tools on the Management Station or Host

Procedure

Step 1 In Server Manager, click Manage and then select Add Roles and Features. The Add Roles and Features
wizard appears.

B Server Manages

Server Manager * Dashboard

Add IluITq’und Features
4

B Dashboard WELCOME TO SERVER MANAGER

Add Servers

' Local Server Create Server Group
!. All Servers o C '_|!"_: aure this local sd Server Manages Properbes
BR File and Storage Services b .

QLRCK STRAT

Step 2 In the Before you begin page, click Next.

| |' Manage Tools View Help

WELCOME TO SERVER MANAGER

Local Server S
B Add Rales and Features Wizard

DESTINATION SERVER
Honoicly MO VDOM LOCAL

Thes wizard helps you mstall roles, role services, o features. You determine whech roles, role zervices, or
features to install based on the computing needs of your orgamzation, such as shanng documents, or
hasting a wabsite,

T remawve roles, role senvices, or features:
Start the Remowe Roles and Features Wizard

Before you continug, verify that the following tasks have been completed:

* The Adeministrator sccount has a SLAONG plsSwond
* Network settings, such as static IP addresses, are configured
* The mast current security updates from Windows Update are instalied

If yeu must venfy that amy of the preceding prerequisites have been completed, clese the wizard
::h'“FlﬂTFG ftaps, ang than nin the wizand i;a:ﬂ

To contirue, clck Next

Skip thes page by default

Step 3 In the Select installation type page, select Role-based or feature-based installation. Click Next.

Step 4 In the Server Selection page, select your server from the list. This server belongs to the same domain as the
HX cluster. Click Next.
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Install RSAT tools on the Management Station or Host .

WELCOME TO SERVER MAMNAGER
Local Server .
Es Add Roles and Features Wizard

t destination s

sezoiacener or e vitbual hard dek oo whech to imasall roles and features

¥ Select o server from the server pool

Sebect awrtual hard disk

Server Pool

Fittar:

hamea

Honclubu HOHVDOM LD, 1026140324 Microsoft Wirdows Senver 2016 Datacertar Bvaluation

) Comouters] found

This page shows servers that are running Windows Server 2012 o & newer refeste of Windows Server,
and that have been added by usang the Add Server
remady-added seners fro

smmand in Sener Manager, Offline servers and
wrhich dats collection is still incomplete ane not shown,

Step 5 In the Select Roles page, click Next.

Step 6 In the Features page, select Remote Server Administration Tools > Feature Administration Tools >

Failover Clustering Tools, and Role Administration Tools > Hyper-V Management Tools > Failover
Clustering Tools. Click Next.
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. Install RSAT tools on the Management Station or Host

rer Manager * Dashbo

TH Dashboard WELCOME TO SERVER MANAGER

I Locsl Sarver e
BiE Ea Ana Rebes and Features Wizand

Select ong or man festures to nstall on the sxlecked server,

Nedows Auds Vides Dxpenence
isnager Admanistrston Kt JCM

L1 AD

1y
- '

Step 7 In the Confirmation page, click Install. Leave the Restart the destination server if required checkbox
unchecked.
Step 8 The Installation Progress page displays installation progress. When installation completes, click Close to

exit the wizard.
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Server Manager * Dashboard

T WELCOME TO SERVER MANAGER

§ Local Server EE——
B Add Roles and Features Wizard

view installation progress

ﬂ keature mstallation

Remote Server Administiation Teols
Feature Administration Tools
Failover Clustering Toals
Fallower Cluster Management Tools
Failower Cluster Module for Windows Power Shell

Role Administration Tools

Hyper-¥ Management Tooks
Hyper-V Module for Windows PowerShell

Hyper-V GLI Management Tools

Managing VMs using Hyper-V Manager

Connecting to Hyper-V Nodes
Complete the following steps to connect to all the Hyper-V nodes in the Hyper-V HX Cluster.

Procedure

Step 1 Open the Server Manager dashboard and click Tools. Then, click Hyper-V Manager. The Hyper-V Manager
console appears.

Step 2 In the left pane, select Hyper-V Manager and click Connect to Server....

Step 3 In the Select Computer dialog box, select Another computer and type in the name of the Hyper-V node
(for example, HXHV 1) that belongs to the Hyper-V cluster. Click OK.

Step 4 Repeat all of the above steps for each node in the Hyper-V HX cluster.
Note For a fresh installation, the storage controller virtual machine (StCt 1VM) in the only virtual machine
that appears in Virtual Machines pane in the Hyper-V Manager console. Virtual machines appear

in the list under this pane as they are added in each node. For more information on how to create
VMs using Hyper-V Manager, see: Creating VMs using Hyper-V Manager, on page 68
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. Creating VMs using Hyper-V Manager

Creating VMs using Hyper-V Manager

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6
Step 7

Step 8
Step 9

Step 10
Step 11
Step 12

Complete the following steps to create VMs using Hyper-V Manager.

Procedure

Open Hyper-V Manager.

Select the Hyper-V server, and right click and select New > Create a virtual machine. The Hyper-V Manager
New Virtual Machine wizard displays.

In the Before you Begin page, click Next.

In the Specify Name and Location page, enter a name for the virtual machine configuration file. The location
for the virtual machine click Next.

In the Specify Generation page, choose either Generation 1 or Generation 2.
In the Assign Memory page, set the start memory value 2048 MB. Click Next.

In the Configure Networking page, select a network connection for the virtual machine to use from a list of
existing virtual switches.

In the Connect Virtual Hard Disk page, select Create a Virtual Hard Disk page, and enter the name,
location and size for the virtual hard disk. Click Next.

In the Installation Options, you can leave the default option Install an operating system later selected.
Click Next.

In the Summary page, verify that the list of options displayed are correct. Click Finish.
In Hyper-V Manager, right-click the virtual machine and click Connect.

In the Virtual Machine Connection window, select Action > Start.

Managing VMs using Failover Cluster Manager

Creating VMs using Failover Cluster Manager

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

Complete the following steps to connect to the Windows Failover cluster (installed along with the Hyper-V
HX cluster) and create new VMs using Failover Cluster Manager.

Procedure

In the Failover Cluster Manager console, under the Actions pane, click Connect to Server...
In the Select Cluster dialog box, click Browse to navigate to the Hyper-V HX cluster. Click OK.
In the left pane, click Roles > Virtual Machines... > New Virtual Machines....

In the New Virtual Machine dialog box, search and select the Hyper-V node where you wish to create new
VMs. Click OK. The New Virtual Machine wizard appears.

In the Before You Begin page, click Next.

In the Specify Name and Location page, choose a name for the VM, and specify the location or drive where
the VM will be stored. Click Next.

In the Specify Generation page, select the generation of virtual machine you want to use (Generation 1 or
Generation 2) and click Next.
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Step 8
Step 9
Step 10
Step 11
Step 12

Configuring HyperFlex Share to SCVMM .

In the Assign Memory page, enter the amount of memory that you want for the VM. Click Next.

In the Connect Virtual Hard Disk page, enter the name, location and hard drive size. Click Next.

In the Installation Options page, select the install location for the OS. Click Next.

In the Summary page, review the options selected and click Finish.

Right-click on the newly created VM, and click Connect.... In the Virtual Machine Connection window,
click Start.

Note By default, the Failover Cluster Manager will assign a default name for the 4 networks created. It
is recommended to rename these network names.

What to do next

To enable redirection of datastore access requests from outside the HX cluster boundary through the
management path, add the following entry to the hosts file on the (remote) machine running Hyper-V manager,
Failover Cluster Manager, or SCVMM Console. For example, edit
C:\Windows\System32\drivers\etc\hosts and add:

cluster mgmt ip \\smb namespace name\datastore name

10.10.10.100 \\hxcluster.company.com\dsl

Configuring HyperFlex Share to SCVMM

Step 1
Step 2
Step 3

Before you begin

Edit the /etc/hosts file on the host running the VMM admin console to resolve the smb access point to
the cluster management IP address of HyperFlex cluster. This IP address is typically used to launch Cisco
HX Connect.

Procedure

Add the cluster to System Center - Virtual Machine Manager (VMM).
In the VMM console, go to Fabric > Servers > All Hosts.

Right-click on the cluster and select Properties.
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. Configuring HyperFlex Share to SCVMM

4 Al Hc:st'i f"g" il Running Running
+ | I ucs900wfe b TestMigration Host Not Responding Running
& ucsod0 ¥ Creste Service 2-10 Running Running
# ucsont &' Create Virtual Machine -1 Runing Running
& ucso0? Gl Refresh pwisServer2016.. Running Running
& uess03 2 Optimize Hosts Running Running
& WIN-NTCO5 B%  Mave to Host Group
ES Uncluster
g Add Cluster Node
'ﬁ' Validate Cluster
? Upgrade Cluster
4 Update Functional Level
A View Networking
== Remove
||E Properties

Step 4 In the Properties window, right-click File Share Storage > Add File Storage.

= =
ﬂ | .

! g

il -

| General File Share Storage

1 S The fallawng file shares will be available a3 storage locatiors for VM deployed to nodes in the chester:

ot || Eile Shage Bath | Accoss Status | Classification | Foee Space | Total Capacity

il euriinhle Siware IE &dd File Share X |z 1.024.00 GB

Specify a valid SMB share path to use for VM

7 Shared Volumes deployment

d

¢ Virtual Switches I File share path:  ‘\hyperv-team.bw-adlocalids1 i I

Te register & file share to this chuster, select a managed file share fram the

Custom Properties
Est or gnter the UNC path fior an unmanaged file share.

For managed shaces, VMM grants file share access to the Actve Dirsctory
computer account for the virtualization duster and the VMM cluster
managemaent account. For unmanaged file shares, ensure that the Active
Directory computer account fior the virtualization duster and the VMM
cluster management account have access to the file shane.

To bring a file share into management: in the VM corsole, open the Fabric
warkspace, click the Providers node, and then click "Add Storage Device"

ok ||| cancel |

| = = |
View Seript Cancel E

Step 5 When mapping completes, the share is added as shown in the screenshot below.
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Shared Voly File Share Storage
Virtual Switches

Custom Propertes

i | Riepair Add.. || Remowe | |
View Script Cancel E

Step 6 Click OK and exit VMM. The HyperFlex Share is now mapped and VMs can be created on this share using
SCVMM.

Re-enabling Windows Defender

Run the following commands to re-enable Windows Defender.
Install Defender from PowerShell

Install-WindowsFeature -Name Windows-Defender
(Optional) Install Defender GUI from PowerShell

Install-WindowsFeature -Name Windows-Defender-GUI
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Troubleshooting Information

* Troubleshooting, on page 73

Troubleshooting

This section contains troubleshooting information for issues seen during Hyper-V deployment.

Symptom or Scenario

Workaround or Recommendation

File Witness Share is not configured.

Create a File Witness Share and
configure it as a Witness Share in
Failover Cluster Manager (FCM). It is
recommended not use the Witness Share
created for anything else.

Waiting for Storage Controller VM (SCVM) times out.

¢ Set the VLAN ID manually and
retry, or,

* Delete the controller VM and retry.

HX Installer fails to join computers to the domain due to incorrect
Active Directory credentials to HX Installer.

Restart HX Installer in the "Deploying
HX Data Platform Installer and Cluster
Configuration" phase in installation, and
provide correct credentials.

Unreliable per node statistics displayed for a node in the duration
when any of controller VMs are down in the cluster.

Use Windows side counters in the time
when any of the controller VMs are
down.
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Symptom or Scenario

Workaround or Recommendation

The FQDN address for HX Connect may be inaccessible after
successful cluster installation.

The default Internet Explorer security
setting on Windows 2008 prevents HX
Connect accessibility with the FQDN
name. As a workaround, try one of the
following:

* Modify the Internet Explorer
setting.

e Use an IP address.

* Use other supported browsers such
as Chrome or Firefox.

For compute-only nodes, performance charts are unavailable in
the HX Connect Dashboard page.

This is a 1 nly nodes.

Windows installation failed with the following error:
Could not detect system partition.

In addition, setupact . 1og shows that the setup could not detect
any available disk as a valid boot device.

1. Switch the boot policy to Embedded
Disk (Any).

2. For the Service Profile or Service
Profile Template use boot policy that
mirrors hx—-nodes-m5 than
compute-nodes-mb.

Migration failed due to incompatible processors.

A cluster may not have a combination
of different CPU types.
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Rack Cisco HyperFlex Nodes

For details on the HyperFlex cluster and node limits, see Cisco HX Data Platform Storage Cluster
Specifications in the latest version of the Release Notes for Cisco HX Data Platform.

For details on the installation of Cisco HyperFlex nodes, refer to respective links from the following table:

Type of Node To Be Installed

Reference

Converged Nodes

HyperFlex HX220c M5 Nodes

Cisco HyperFlex HX220c M5 Node Installation
Guides

HyperFlex HX240c M5 Nodes

Cisco HyperFlex HX240c M5 Node Installation
Guides

| A

Important  Compute-only nodes are not supported with Hyper-V in 3.0(1a)

Setting Up the Fabric Interconnects

Configure a redundant pair of fabric interconnects for high availability. Connect the two fabric interconnects
directly using Ethernet cables between the L1 and L2 high availability ports. Connect Port L1 on fabric
interconnect A to port L1 on fabric interconnect B, and Port L2 on fabric interconnect A to port L2 on fabric
interconnect B. This allows both the fabric interconnects to continuously monitor the status of each other.

Verify and obtain the following information before connecting the fabric interconnects.
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Item

Description

Verify the physical connections of the fabric
interconnects.

* Console port for the first fabric interconnect must be
physically connected to a computer or console server.

* Management Ethernet port (mgmt0) must be connected
to an external hub, switch, or router.

* L1 ports on both the fabric interconnects must be directly
connected to each other.

* L2 ports on both the fabric interconnects must be directly
connected to each other.

Verify console port parameters on the
computer terminal.

* 9600 baud
« 8 data bits
* No parity

* 1 stop bit

Obtain information for initial setup.

Collect the following information for initial setup:
* System name
* Password for admin account
* Three static IP addresses
* Subnet mask for three static IP addresses
* Default gateway IP address
* DNS server IP address

* Domain name for the system

Both fabric interconnects must go through the same setup process. Set up the primary fabric interconnect and
enable for cluster configuration. When you use the same process to set up the secondary fabric interconnect,
it detects the first fabric interconnect as a peer.

Configure the Primary Fabric Interconnect Using GUI

You can either follow the procedure below for configuring the primary fabric interconnect or watch Cisco

UCS Manager Initial Setup part 1.

[ ]

Attention  [Pv4 addressing is required for HyperFlex.
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Step 1

Step 2
Step 3
Step 4
Step 5

Step 6
Step 7
Step 8
Step 9

Step 10

Configure the Primary Fabric Interconnect Using GUI .

Procedure

Power up the fabric interconnect.
You will see the power on self-test messages as the fabric interconnect boosts.

If the system obtains a lease, go to step 6, otherwise, continue to the next step.
Connect to the console port.
At the installation method prompt, enter gui.

If the system cannot access a DHCP server, you are prompted to enter the following information:

* [Pv4 address for the management port on the fabric interconnect.
* [Pv4 subnet mask for the management port on the fabric interconnect.

* [Pv4 address for the default gateway assigned to the fabric interconnect.

Copy the web link from the prompt into a web browser and go to the Cisco UCS Manager GUI launch page.
On the Cisco UCS Manager GUI launch page, select Express Setup.

On the Express Setup page, select Initial Setup and click Submit.

In the Cluster and Fabric Setup area:

a) Click the Enable Clustering option.
b) For the Fabric Setup option, select Fabric A.
¢) Inthe Cluster IP Address field, enter the [IPv4 address that Cisco UCS Manager will use.

In the System Setup area, complete the following fields:

Field Description

System Name field The name assigned to the Cisco UCS domain.

In a standalone configuration, the system adds "-A"
to the system name. In a cluster configuration, the
system adds "-A" to the fabric interconnect assigned
to fabric A, and "-B" to the fabric interconnect
assigned to fabric B.

Admin Password field The password used for the Admin account on the
fabric interconnect.

Choose a strong password that meets the guidelines
for Cisco UCS Manager passwords. This password
cannot be blank.

Confirm Admin Password field The password used for the Admin account on the
fabric interconnect.

Mgmt IP Address field The static IPv4 address for the management port on
the fabric interconnect.
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Step 11

Appendix |

Field

Description

Mgmt IP Netmask field or Mgmt IP Prefix ficld

The IPv4 subnet mask prefix for the management port
on the fabric interconnect.

Note The system prompts for a Mgmt IP
Netmask or a Mgmt IP Prefix based on
what address type you entered in the Mgmt

IP Address field.
Default Gateway field The IPv4 address for the default gateway assigned to
the management port on the fabric interconnect.
Note The system prompts for a Default
Gateway address type based on what type
you entered in the Mgmt IP Address field.
DNS Server IP field The IPv4 address for the DNS Server assigned to the

fabric interconnect.

Domain Name field

The name of the domain in which the fabric
interconnect resides.

Click Submit.
A page displays the results of your setup operation.

Configure the Subordinate Fabric Interconnect Using GUI

You can either follow the procedure below for configuring the subordinate fabric interconnect or watch Cisco

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6
Step 7

UCS Manager Initial Setup part 2.

Procedure

Power up the fabric interconnect.

You will see the power-up self-test message as the fabric interconnect boots.

It the system obtains a lease, go to step 6, otherwise, continue to the next step.

Connect to the console port.

At the installation method prompt, enter gui.

If the system cannot access a DHCP server, you are prompted to enter the following information:

* [Pv4 address for the management port on the fabric interconnect

* [Pv4 subnet mask for the management port on the fabric interconnect

* [Pv4 address for the default gateway assigned to the fabric interconnect

Copy the web link from the prompt into a web browser and go to the Cisco UCS Manager GUI launch page.

On the Cisco UCS Manager GUI launch page, select Express Setup.
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Step 8

Step 9

Step 10

Step 11

Step 12

How to upload the iso and img file to the installer VM using WinSCP .

On the Express Setup page, select Initial Setup and click Submit.

The fabric interconnect should detect the configuration information for the first fabric interconnect.

In the Cluster and Fabric Setup Area:
a) Select the Enable Clustering option.
b) For the Fabric Setup option, make sure Fabric B is selected.

In the System Setup Area, enter the password for the Admin account into the Admin Password of Master
field.
The Manager Initial Setup Area is displayed.

In the Manager Initial Setup Area, complete the following:

Field Description

Peer F1 is IPv4 Cluster enabled. Please Provide |Enter an IPv4 address for the MgmtO interface on the

Local Fabric Interconnect Mgmt0 IPv4 Address |local fabric interconnect.
field

Click Submit.

A page displays the results of your setup operation.

How to upload the iso and img file to the installer VM using

WinSCP

Step 1

Step 2

You may choose to use the Installer VM as host for the ISO and IMG files to install Hyper-V. To accomplish
that you need to upload the Windows ISO and the Cisco HyperFlex driver image to the installer.

For the pupose of this guide we will use WinSCP, you can use whatever SCP client you have available.

Procedure

Download a SCP client for Windows. It could be WinSCP (https://winscp.net/eng/download.php) and install
it on your workstation.

Connect to your installer VM from WinSCP. Username root and password Cisco123

Important Systems ship with a default password of Ciscol123 that must be changed during installation. You
cannot continue installation unless you specify a new user supplied password.

Cisco HyperFlex Systems Installation Guide for Microsoft Hyper-V, Release 3.0 .


https://winscp.net/eng/download.php

Appendix |

. How to upload the iso and img file to the installer VM using WinSCP

Session
File protocol:

|scp

Host name: Port number:

|10.101.1.228 | %Ij|

User name: Password:

[root

| |.ll...ll.| |

Elogn |¥|| Close Help

Step 3 Accept the key and add to the cache.

Continue connecting to an unknown server and add its
host key to a cache?

The server's host key was not found in the cache. You have no guarantee that
the server is the computer you think it is.

The server's Ed25519 key details are:
Algorithm: ssh-ed25519 256
SHA-256:  wOOV4/jigyLFEuRBW/Np4JajlUcmMN7aHOENMnSfuwwhN4=
MD3: Sdibdid1:db:6c:d5:70:44: T Te:06:07:17:96:ac:b0

If you trust this host, press Yes. To connect without adding host key to the
cache, press No. To abandon the connection press Cancel.

Copy key fingerprints to dipboard

Yes |v|| No || Cancel || Hep |
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Step 4 Once connected browse to the folder /var/www/localhost/images/ on the installer. Browse to where to local
files are located on your machine.
Step 5 Transfer the files. Filenames can be copied if you access the URL in a browser: http.//<controller IP>/images/
L ] =% Index of fimages/ * 1]
“ C @ 10101.1.228images/ « 0 ¢

Index of /images/

22
HxInstall-HyporV=v3.0.18=-29490, ing ld=-Apr=2018 09103 E55360000
an_windows_perver 2016 x64_dvd 9716492.i80 25-Sep-2017 09:18 5683301884

DNS Records

Refer to the list below for the DNS records that must be added to your environment.

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername
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Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "" -ZoneName "Ciscolab.dk" -AllowUpdateAny -IPv4Address ""
-TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "-CNTL" -ZoneName "Ciscolab.dk" -AllowUpdateAny
-IPv4Address "" -TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "-CNTL" -ZoneName "Ciscolab.dk" -AllowUpdateAny
-IPv4Address "" -TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "-CNTL" -ZoneName "Ciscolab.dk" -AllowUpdateAny
-IPv4Address "" -TimeToLive 01:00:00 -CreatePtr -computername

Add-DnsServerResourceRecordA -Name "-CNTL" -ZoneName "Ciscolab.dk" -AllowUpdateAny
-IPv4Address "" -TimeToLive 01:00:00 -CreatePtr -computername

Updating HX Service Account Password

N

A new password must be updated within an HX Cluster if the password expired or was changed voluntarily.
Perform the following step to update the Cisco HX Service Account Password.

Note

The access to VM and datastores will still continue to work without the new password. However, the cluster
will experience some issues with the Alert, Systems Status, Support Bundle and Datastore Access reporting.

Before you begin
Ensure that the Cisco HX Service Account User Name is in the following format:

username@domain.com

Procedure

Run the resethypervcred -u command from one of the Storage Controller node within the cluster.

Example:
The following is an example of the command with sample output:

root@cvmhvl:~# resethypervcred -u

Enter service admin name:administrator@domain.com
Enter service admin passwd:

Enter local admin name:administrator

Enter local admin passwd:

Hyperv creds updated successfully

Login to each controller vim as the root user and run restart hxHyperVSvcMgr.
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After you have completed the reset and service restarts, then login to HX Connect as the HX Service Account
User to verify your login works and HX Connect is displaying the cluster information.
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